
 APPLICATION NOTE 

R20AN0701EJ0100  Rev.1.00  Page 1 of 42 
Dec.22.22  

Renesas RX Family 
Using QE for Capacitive Touch for IAR EWRX 
Introduction 
This application note explains the steps involved in automatically adjusting and monitoring a touch sensor in 
a project of the IAR Embedded Workbench for Renesas RX (IAR EWRX) generated by the Smart 
Configurator with the use of the standalone version of QE for Capacitive Touch (standalone-version QE), 
which is a tool for development involving capacitive touch sensors. 

Target Evaluation Kit 
RSK-RX140 (RTK551406BS00000BE): CPU board (R5F51406BDFN) 

Operating Environment 
IDE IAR Embedded Workbench for Renesas RX version 4.20.3 or later 
Configuration tool RX Smart Configurator V2.15.0 or later 

FIT module 

RX family RX Driver Package Ver.1.36 or later 
Firmware Integration Technology (FIT) for RX family 
• CTSU QE API (r_ctsu_qe): V2.10 (or later) 
• SCI Driver (r_sci_rx): V4.5 (or later) 
• Touch QE API (rm_touch): V2.10 (or later) 

Toolchain IAR EWRX Toolchain 
QE Standalone version of QE for Capacitive Touch V3.1.0 or later 

 
Note: Download tools from the following URLs in advance. 
 
• URL for downloading the IAR Embedded Workbench for Renesas RX 

https://www.iar.com/products/architectures/renesas/iar-embedded-workbench-for-renesas-rx/ 
 

• URL for downloading QE for Capacitive Touch 
https://www.renesas.com/us/en/software-tool/qe-capacitive-touch-development-assistance-tool-
capacitive-touch-sensors#download 
 

• URL for downloading the RX Smart Configurator 
https://www.renesas.com/jp/en/software-tool/rx-smart-configurator#download 
 

• URL for downloading the RX driver package 
https://www.renesas.com/jp/en/software-tool/rx-driver-package 
 

• RX Smart Configurator User’s Guide: IAREW 
https://www.renesas.com/us/en/document/mat/rx-smart-configurator-users-guide-iarew 
 

• Renesas Starter Kit for RX140 User’s Manual 
https://www.renesas.com/us/en/document/mat/renesas-starter-kit-rx140-users-manual 
 

• RX140 Group User’s Manual: Hardware Rev.1.10 
https://www.renesas.com/us/en/document/mah/rx140-group-users-manual-hardware-rev110 

 

https://www.iar.com/products/architectures/renesas/iar-embedded-workbench-for-renesas-rx/
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Figure 1  Configuration for Using QE for Capacitive Touch with IAR EWRX 
 
  

Standalone version of  
QE for Capacitive Touch 

• Generates source code for  
capacitive touch sensors. 

IAR EWRX • Building 

Smart Configurator 

• Generates source code of drivers and 
middleware for use with QE for Capacitive 
Touch. 

• Generates IAR EWRX projects for building 
the code generated by the Smart 
Configurator in the IAR EWRX Toolchain. 
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1. Installation 
1.1 Installing the IAR EWRX 
After starting the downloaded installer, install the IAR EWRX according to the procedure prompted by the 
installer. 

Log in with administrator rights to proceed with installation. 

 

1.2 Installing the Smart Configurator 
After starting the downloaded installer, install the Smart Configurator according to the procedure prompted 
by the installer.  

Log in with administrator rights to proceed with installation. 

 

1.3 Installing the Standalone Version of QE for Capacitive Touch 
The downloaded zip file has both the plugin version of QE for Capacitive Touch and the standalone version 
of QE for Capacitive Touch. 

1. Expand the downloaded zip file. 
2. Since the standalone-version QE for Capacitive Touch is stored in the QE-CapTouch folder, move that 

folder to a desired location. The QE-CapTouch folder must be moved to a folder that is close to the root of 
the drive so that the Windows path name does not exceed the limit on the number of characters (260 
characters). 
 Examples of folder name: C:¥Renesas, C:¥QeTouch 
Note that the tool can be launched from "qe-captouch.exe" that is in the "QE-CapTouch¥eclipse" folder. 

 

2. Preparing a Project 
Using the Smart Configurator, create an IAR EWRX project that uses the standalone-version QE. The Smart 
Configurator has a simple wizard for creating projects. An IAR EWRX project can be created by specifying 
the location, file name, platform, toolchain, and project type of a project, making the RTOS setting, and 
setting the locations of FIT modules. Follow the procedure below to create a new IAR EWRX project. 

Sections 2.1 to 2.3 explain the procedure of To Create Project in the workflow diagram of the standalone-
version QE. 

  

Figure 2-1  Standalone-Version QE - Workflow Diagram: To Create Project 
  

Workflow diagram 
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2.1 Creating a Configuration File 
1. From the Windows start menu, select [Renesas Electronics Smart Configurator] and then [Smart 

Configurator for RX Vx.x.x]. The main window of the Smart Configurator will be started. 
Note: Vx.x.x should be replaced with the version in use. 

 

Figure 2-2  Starting the Smart Configurator 

 

2. Select [New…] from the [File] menu or click on the  [New Configuration File] button on the main 
toolbar. 

 

Figure 2-3  Creating a New Smart Configuration File 
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3. The dialog box for making Smart Configurator settings is displayed. 
 Set the following items. 

(1) [Platform:] Enter "RX140" and select "RSKRX140 (R5F51406BxFN)" under "Board" that is  
 displayed after filtering has finished. 

(2) [Toolchain:] Select "IAR EWRX Toolchain". 
(3) [File name:] Enter the name of the project to be created. 
(4) [Location:] Confirm the folder in which the project is to be created. To change the project  

 folder, click on [Browse…] and select the folder for saving the project. 
 Click on [Next >] and then set the items for the use of FIT modules and middleware. 

 

Figure 2-4  Smart Configurator Settings (1) 

 
  

(2) 

(3) 
(4) 

(1) 
(1) 

(4) 
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 Confirm that [RTOS:] in [RTOS Settings] is "None" and set the location of the FIT modules.  
Unzip the downloaded FIT module zip file. 
Click on [Browse…] and select the folder containing the unzipped FIT modules. 

 

Figure 2-5  Smart Configurator Settings (2) 

 
 Clicking on [Finish] creates a configuration file (*.scfg) and displays the main window. 

 

Figure 2-6  Main Window of Smart Configurator 
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2.2 Setting the Smart Configurator 
When a tab at the bottom of the Smart Configurator view is selected, the displayed contents are switched. 
Select a tab as required and set the necessary items. 

 

Figure 2-7  Tabs of the Smart Configurator View 

 
1. Setting clocks 

Select the [Clocks] tab. 

 

Figure 2-8  Selecting the [Clocks] Tab 

 
 VCC: Enter "5.0". 
 Main clock: Tick the checkbox (√). 

Enter values so that the frequency of FCLK, ICLK, and PCLDK is 48 MHz, and the frequency of 
PCLKB is 24 MHz, as shown in Figure 2-9. 

 

Figure 2-9  Setting Clocks 
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2. Setting the system 
Select the [System] tab. 

 

Figure 2-10  Selecting the [System] Tab 

 
 Confirm that "FINE" is selected in [Debug interface setting]. 

 

Figure 2-11  Setting the System 

 
3. Setting software components 

Select the [Components] tab. 

 

Figure 2-12  Selecting the [Components] Tab 
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 Add a driver, middleware, and serial interface and set them up. 

 

Figure 2-13  Setting Software Components 
 

 To add a component, click on the  [Add component] button to open the "New Component" dialog 
box and select the component to be added. 

 

Figure 2-14  Displaying the "New Component" Dialog Box 
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a. Adding a CTSU driver 
Open the "New Component" dialog box, select "r_ctsu_qe", and click on [Finish]. 

 

Figure 2-15  Selecting "r_ctsu_qe" 

 
• Click on the added "r_ctsu_qe" module and enable the TSCAP pin and the two TS pins to be used. 

For the assignment between the TS pins and touch sensors, confirm the user’s manual of the 
target board in use. 

 

Figure 2-16  Enabling the Pins in Use ((1): r_ctsu_qe, (2): TSCAP Pin, (3): Two TS Pins) 

 
  

(1)→ 
←(2) 

←(3) 
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b. Adding touch middleware 
Open the "New Component" dialog box, select "rm_touch_qe", and click on [Finish]. 

 

Figure 2-17  Selecting "rm_touch_qe" 

 
• Click on the added "rm_touch_qe" module and set up serial communications monitoring through a 

UART. 
Set items in [Value] as shown below. 
# Support for QE monitoring using UART: Include code to update sensor data for monitor 
# Support for Serial tuning using UART: Include code to serial tuning 
# UART channel: UART1 

 

Figure 2-18  Selecting the Property of "rm_touch_qe" ((1): rm_touch_qe) 

 
  

(1)→ 
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c. Adding a serial interface 
Open the "New Component" dialog box, select "r_sci_rx", and click on [Finish]. 

 

Figure 2-19  Selecting "r_sci_rx" 

 
• Click on the added "r_sci_rx" module to display the related ports on the configuration panel and set 

items in [Value] as shown below. 
# Use ASYNC mode: Include  
# Include software support for channel 1: Include 
# Transmit end interrupt: Enable 
Resources > SCI > SCI1: Tick the checkbox (√). 

RXD1, TXD1: Tick the "Used" checkbox (√). 

 

Figure 2-20  Setting "r_sci_rx" ((1): r_sci_rx) 
  

(1)→ 
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• Assign the pin functions for SCI1. 
Select the [Pins] tab. 

 

Figure 2-21  Selecting the [Pins] Tab 

 
• Expand "Serial communications interface" in the tree next to the [Pin Function] panel on the [Pin 

configuration] tabbed page and select SCI1. 
Assign the "RXD1" function to "P30" and the "TXD1" function to "P26". 

 

Figure 2-22  Assigning Pin Functions for SCI1 ((1): [Pin Function] Tab, (2): SCI1) 

 
  

(1)
↓ 
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2.3 Generating Code 
Generate code. 

1. Click on the  button of the Smart Configurator and generate code. 

 

Figure 2-23  Generating Code 

 
When the following message box is displayed, click on [Proceed]. 

 

Figure 2-24  Message at Code Generation 

 
2. Confirm that "Code generation is successful" is displayed in the Console view. 

 

Figure 2-25  Termination of Code Generation 
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3. Terminate the Smart Configurator by selecting [Exit] from the [File] menu. 

 

Figure 2-26  Terminating the Smart Configurator 

 
4. In Windows Explorer, confirm that an IAR IDE Workspace file (*.eww) with the  icon has been created 

in the folder with the location specified in section 2.1.3 (3). 

 

Figure 2-27  IAR EWRX Workspace Folder 

 
5. Set items to allow launching the Smart Configurator from the [Tools] menu in the IAR EWRX window. 

Double-click on the IAR IDE Workspace file created in Windows Explorer to start the IDE. In the opened 
IAR EWRX window, select [Configure Tools…] from the [Tools] menu to open the [Configure Tools] dialog 
box. 

 

Figure 2-28  Tools 
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 In the [Configure Tools] dialog box, click on [New] and enter values for items (2) to (5) shown below. 
(1) Menu Content: The contents entered in [Menu Text] are displayed. 
(2) Menu Text: Smart Configurator for RX 
(3) Command: [Installation folder]¥eclipse¥SmartConfigurator.exe 
(4) Argument: $PROJ_FNAME$.scfg 
(5) Initial Directory: $PROJ_DIR$ 
Click on [OK] to close the "Configure Tools" window. 

 

Figure 2-29  Setting Tools 

 
 The Smart Configurator can now be selected from the [Tools] menu. 

 

Figure 2-30  Settings Reflected in the [Tools] Menu 
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6. Next, right-click on the project name in the [Workspace] window, then select [Rebuild All] to perform 
building. After building has finished, confirm that no errors are indicated in the [Build] window or status bar 
at the bottom of the main window. 

 

Figure 2-31  Building 

 
7. Select [Exit] from the [File] menu. In the [IaeIdePm] dialog box that is displayed, click on [Yes] to save the 

project and terminate the IAR EWRX workspace. 

 

Figure 2-32  Terminating the IAR EWRX Workspace 
  

Before build 
↑ Status bar 

After build 
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2.4 Setting the Project Folder and Target MCU 
After creating a project, launch the standalone-version QE. The folder containing the created project and 
MCU product information should be set, according to "1. Preparation" in the workflow diagram. 

  

Figure 2-33  Standalone-Version QE - Workflow Diagram: <Step 1> Preparation 

 
1. Select the project folder. 

Click on […] to the right of the input area under "To Select a Project Folder" to select the folder storing the 
project. 

2. Select product information on the microcontroller. 
Click on […] to the right of the input area under "To Select a MCU Name" to select an MCU by clicking on 
the  labels in the "Product Name of Target MCU" dialog box that is displayed. 
(1) Family Name Select "RX". 
(2) Group Name Select "RX140". 
(3) Pin Number Select "LQFP/80pin:FN". 
(4) ROM Size Select "256KB:6". 
(5) Product Name "R5F51406xxFN" will be displayed when the above items (1) to (4) have been 

selected correctly. 
Click on [OK] to close the dialog box. 

 

Figure 2-34  "Product Name of Target MCU" Dialog Box 

 
  

Workflow diagram 
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3. Preparing the Touch Interfaces 
Set items according to "2. Configuration" in the workflow diagram. 

  

Figure 3-1  Standalone-Version QE - Workflow Diagram: <Step 2> Configuration 

 

3.1 Creating a Touch Interface Configuration 
Create a new touch interface configuration. 

 
1. Click on  under "To Prepare a Configuration" and select "Create a new configuration". The "Create 

Configuration of Touch Interfaces" window appears and displays the area for placing touch interfaces. 

  

Figure 3-2  Creating a Touch Interface Configuration 
  

Workflow diagram 
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2. Clicking on [Button] in the "Touch I/F" panel on the right side of the "Create Configuration of Touch 
Interfaces" window enables the placement of buttons at the cursor position. Clicking on a position in the 
area causes a button to be placed there. 
After having placed two buttons as shown below, press the [ESC] key to stop adding touch interfaces. 

  

Figure 3-3  Adding Buttons 

 
3. Double-click on the placed buttons and set the following items in the displayed "Setup Touch Interface" 

dialog box. 
Button00: [Name] TS_B1 [Touch Sensor] TS11 [Resistance] 560 
Button01: [Name] TS_B2 [Touch Sensor] TS12 [Resistance] 560 
The color of the buttons will change to green if the items of the touch interface have been set correctly. 

 

Figure 3-4  Setting the Touch Interface Items for Button00 

 

Adding buttons After the [ESC] key is pressed 
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4. Confirm that the color of the two buttons that have been placed is green and click on [Create] to close the 
window. 

 

Figure 3-5  Stopping Creation of Touch Interface Configurations 

 
5. The touch interface configurations are displayed on the [Tuning] panel in the "Main" window. 

 

Figure 3-6  Touch Interface Configurations 
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3.2 Outputting Files for Tuning Touch Sensors 
After the files for tuning touch sensors have been output to the specified folder, set the frequency of the 
peripheral module clock of the MCU and the voltage supplied to the microcontroller. 

 
1. Click on [Output Files] to display the "The output folder of parameter files" dialog box. Click on the folder 

to which the files are to be output and then click on [Select Folder]. 

   

Figure 3-7  Outputting Files for Tuning 

 
In the example shown in this figure, the "QE_FirstAdjustments" folder is created under the project folder 
and selected as the folder for output of the parameter files. 

 
2. When the folder for outputting files is selected, the "Frequency of Peripheral Module Clock (PCLKB or 

PCLKL)" dialog box appears. Enter "48" for the frequency and click on [OK]. 

 

Figure 3-8  Setting the Frequency of the Peripheral Module Clock (PCLKB or PCLKL) 

 
3. In the "Operating Voltage of MCU (VCC)" dialog box that appears next, click on . Then select [5.0V : 

(4.5V ≤ VCC ≤ 5.5V)] as the voltage value and click on [OK]. Since an external power supply is used, 
confirm the electrical characteristics of the microcontroller in use. 

 

Figure 3-9  Setting the Operating Voltage (VCC) of the MCU 
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4. Finally, the "QE for Capacitive Touch" dialog box appears. Follow the instructions in the dialog box. The 
same contents are displayed in the "Console" panel at the bottom of the window. 

 

Figure 3-10  "QE for Capacitive Touch" Dialog Box 

 

 

Figure 3-11  "Console" Panel 
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3.3 Implementing Programs for Tuning 
In the IAR EWRX project, modify the main program to operate the programs for tuning, add the programs for 
tuning, add compiler options, and make settings for debugging. 

 
1. In Windows Explorer, double-click on "  <workspace file name>.eww" to open the IAR EWRX window. 

 

Figure 3-12  IAR EWRX Window 

 
2. Change the main function. 

Implement processing for calling the touch main function in the main() function. 
 Double-click on main.c to open the file. Add the declaration of the touch main function and code for 

calling it, then save main.c and close the file. 
Line 5: extern void qe_touch_main(void); Line 9: qe_touch_main(); 

 

Figure 3-13  Modifying the main() Program 

 

←Added 

←Added 
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3. Add the files for tuning. 
Copy the files for tuning to the "qe_gen" folder and add the files for tuning to the project. 
a. Create a "qe_gen" folder in the folder for storing the workspace file. Copy all files in the folder where 

the files for tuning were saved to the "qe_gen" folder. 

 

Figure 3-14  Copying the Files for Tuning  

 
b. Right-click on the project name in the [Workspace] window and select in the order of [Add] → [Add 

Group…]. In the [Add Group] dialog box, enter "qe_gen" and click on [OK]. 

 

Figure 3-15  Adding a Group 

 
c. Right-click on the added group name and select in the order of [Add] → [Add Files…]. In the [Add 

Files] dialog box, select all files and click on [Open]. 

 

Figure 3-16  Adding Files 



Renesas RX Family Using QE for Capacitive Touch for IAR EWRX 

R20AN0701EJ0100  Rev.1.00  Page 27 of 42 
Dec.22.22  

3.4 Building a Project 
1. Add the compiler options. 

Add the include paths and symbol definitions of the files for tuning to the preprocessor settings. 
 Right-click on the project name in the [Workspace] window and select [Options…] to open the 

[Options] dialog box. 
 Select "C/C++ Compiler" in [Category:] and then select the [Preprocessor] tab. 

  

Figure 3-17  Displaying the [Preprocessor] Tab of "C/C++ Compiler" 

 
a. Add the include paths. 

(1) On the [Preprocessor] tabbed page, click on […] in [Additional include directories: (one per line)] 
to open the [Edit Include Directories] dialog box. 

(2) Scroll down to the bottom of the [Edit Include Directories] dialog box and click on <Click to add>. 
(3) The [Add Include Directory] dialog box appears. Select the folder where the files for tuning were 

saved and click on [Select Folder]. 

              
 

 

Figure 3-18  Adding an Include Directory 

(1)→ 

(3) 

←(2)→ 
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(4) Change the path specification mode of the added include directory from absolute path to relative 
path. 
Click on  in the [Edit Include Directories] dialog box and select the relative directory that starts 
with "$PROJ_DIR$". After confirming that the path has been changed to a relative path in the 
[Edit Include Directories] dialog box, click on [OK]. 

  
 

Figure 3-19  Changing the Path to the Include Directory to a Relative Path 
 

b. Enter "QE_TOUCH_CONFIGURATION" in [Defined symbols: (one per line)]. 

 

Figure 3-20  Adding a Symbol Definition 
 
2. Next, set up the debugger. 

 Select "Debugger" in [Category:] and select the [Setup] tab. 
 Click on  in [Driver:] and select "E2 Lite/EZ-CUBE2". 
 Enter "main" in [Run to:] and tick the checkbox (√). 
 Click on [OK] to close the [Options] dialog box. 

      

Figure 3-21  Debugger - [Setup] Tab  
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3. Set up the hardware. 
a. The [E2/E2 Lite] menu will become selectable from the menu bar. Select [Hardware Setup…] from the 

[E2/E2 Lite] menu. 

 

Figure 3-22  Selecting [Hardware Setup…]  

 
b. Select the [MCU] tab in the [Hardware Setup] dialog box and set the following items. 

• [ICLK frequency:] in [MCU] Enter "48.000". 
• [Power supply] "Power target from the emulator (MAX 200mA)" 

If the checkbox is ticked (√), cancel the selection by clicking on the checkbox. 
Click on [OK]. 

 

Figure 3-23  Hardware Setup - [MCU] Tab 
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4. Build the project with the files for tuning included.  
Right-click on the project name in the [Workspace] window, then select [Rebuild All] to perform building.  
After building has finished, confirm that no error has occurred in the [Build] window or status bar at the 
bottom of the main window. 

 

Figure 3-24  Building Including Files for Tuning 

 
  

Before build 

↑ Status bar 

After build 
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4. Tuning Touch Sensors 
Connect RSK-RX140 with the host PC. Start debugging of the IAR EWRX project and perform automatic 
tuning processing for touch sensors in the standalone-version QE. 

  

Figure 4-1  Standalone-Version QE - Workflow Diagram: <Step 3> Tuning 

 

4.1 Connecting the RSK-RX140 Board with a PC 
Connect the RSK-RX140 board with a host PC as shown in Figure 4-2. A center-positive power supply with a 
stabilized DC output (min. 10 W) must always be used as the power supply for connection to the board. 

 

 
 

Figure 4-2  Connecting the RSK-RX140 Board 
  

Workflow diagram 
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4.2 Starting Tuning 
Execute the tuning program with IAR EWRX to start tuning in the standalone-version QE. 

1. Execute the tuning program with IAR EWRX. 
(1) Select [Download and Debug] from the [Project] menu and start debugging. 
(2) After debugging has started, execution is stopped in the main() program. 
(3) Select [Go] from the [Debug] menu and start execution. 

  
 

   

Figure 4-3  <Step 3> Tuning: Executing the Program 
  

(1) 

(3) 

(2) 
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2. Start automatic tuning in the standalone-version QE. 
Click on [Start Tuning] in the workflow to start automatic tuning in the standalone-version QE. For the 
interactive steps in automatic tuning processing, follow the instructions in the dialog box that provides 
guidance. 

 

Figure 4-4  Automatic Tuning Processing 

 
a. Confirm the "Automatic Tuning Processing" dialog box for guidance in the automatic tuning process as 

required. Normally, no manipulations are required during the initial stages of tuning. 

 

Figure 4-5  "Automatic Tuning Processing" - Initial Tuning 

 
b. If the touch sensitivity has been found to be measurable after a number of automated steps, a dialog 

box with a notification similar to that shown in the figure below will appear. This is the first interactive 
step in the tuning process. 
• Touch the sensor (TS_B1/TS11) that is indicated in the dialog box. 
• While touching the sensor, the bar graph will grow to the right and the counted numerical value will 

increase. 
• While continuing to touch the sensor, press any key on the PC keyboard to secure the measured 

value. 

 

Figure 4-6  "Automatic Tuning Processing" - Measuring the Touch Sensitivity (TS_B1) 
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c. Repeat the previous procedure for TS_B2/TS12. 

 

Figure 4-7  "Automatic Tuning Processing" - Measuring the Touch Sensitivity (TS_B2) 

 
d. Once automatic tuning has been completed for both buttons, the thresholds can be checked in a 

dialog box like that shown below. These thresholds are used by the middleware to determine if touch 
events have occurred. 

 

Figure 4-8  "Automatic Tuning Processing" - Displaying the Measurement Results 

 
3. Stop tuning. 

Click on the [Continue the Tuning Process] button in the dialog box that shows the thresholds of the touch 
sensors. The automatic tuning process is finished at this point and the debug session with the target 
board is cut off. 

 

Figure 4-9  "Automatic Tuning Processing" - Continuing the Tuning Process 
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4.3 Acquiring the Tuning Result 
Acquire the tuning result in the standalone-version QE. 

1. Stop debugging of IAR EWRX. 
Select [Stop Debugging] from the [Debug] menu. 

 

Figure 4-10  Tuning Related 

 
2. Click on the [Output Parameter Files] button in the standalone-version QE. 

In the "The output folder of parameter files" dialog box, select a folder and click on [Select Folder]. In the 
example below, the "qe_tuning_r1" folder was created in advance so it could be selected here. 

  

Figure 4-11  Outputting the Tuning Result 
  



Renesas RX Family Using QE for Capacitive Touch for IAR EWRX 

R20AN0701EJ0100  Rev.1.00  Page 36 of 42 
Dec.22.22  

3. Reflect the values from tuning of the touch interfaces in the IAR EWRX project. 
Open the folder where the files are saved and copy the following three files to the "qe_gen" folder in the 
workspace folder. If the file contents before tuning are unnecessary, overwrite the files. If the file contents 
are necessary, save the files before performing copy. 

  

Figure 4-12  Copying the Files with Tuned Values 

 
4. Build the IAR EWRX project and generate modules in which the tuned values of touch interfaces are 

reflected. For the method of building, refer to section 3.4.4. 
 

  

<Files to be copied> 
qe_touch_define.h 
qe_touch_config.h 
qe_touch_config.c 
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5. Coding and Monitoring 
Using the module of section 4.3 4 that was built with the parameter files obtained in automatic tuning 
processing, perform monitoring in the standalone-version QE. 
A facility for scanning the state of touch sensors is implemented in a function included in 
"qe_touch_sample.c", which is a tuning file obtained in "2. Configuration" of the workflow diagram of the 
standalone-version QE. Operation can be checked through monitoring without any particular requirements to 
change the program code. 
 

5.1 Monitoring 
Execute the program built with IAR EWRX, according to the procedure in section 4.2.1. 

1. Start monitoring. 
Click on the [Connect] button under "To Connect UART" in the workflow diagram. Wait for a while until 
connection is completed. 

      

Figure 5-1  <Step 4> Coding and Monitoring: Connect 

 
2. When connection is established, "Connecting via serial communication (UART/USB)" is displayed for 

"Communication Status" in the Board Monitor view. 

 

Figure 5-2  State of Serial Communications 
  

Workflow diagram 



Renesas RX Family Using QE for Capacitive Touch for IAR EWRX 

R20AN0701EJ0100  Rev.1.00  Page 38 of 42 
Dec.22.22  

3. Click on [Enable Monitoring]. The display is switched between "Monitoring: Disabled" and "Monitoring: 
Enabled". 

        

Figure 5-3  Enabling the Monitoring Function 

 
4. Touch the button TS_B2 on the target board. In the Board Monitor view, a finger icon on the button like 

that in the image below indicates that the button is being touched. 

 

Figure 5-4  Board Monitoring: Finger Icon 

 
5. To see a graphical representation of the counted values, click on the [Status Chart] tab as shown below. 

 

Figure 5-5  Selecting the [Status Chart] Tab 

 
 Select "TS_B1@ config01" from the pull-down menu. 

 

Figure 5-6  Selecting "Touch I/F" 
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 The graph will begin to display a running depiction of the values. The increases in the counted values 
while the TS_B1 button on the target board is being touched can be confirmed from the graph. The 
green line indicates the threshold, which is used by the "rm_touch_qe" FIT module to determine 
whether the button is being actuated, that is, touched. The red belt at the bottom of the graph 
indicates the periods over which the counted value was exceeding the threshold so that the button is 
judged to have been touched. 

 

Figure 5-7  [Status Chart] Tab 
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6. To see a graphical representation of counted values that indicate multiple touch sensors being touched, 
use the [Multi Status Chart] tab. It will be displayed when the touch interface is selected. 

 

Figure 5-8  [Multi Status Chart] Tab 

 

5.2 Disconnecting Serial Communications 
1. Stop monitoring. 

When the monitoring function is enabled, click on [Enable Monitoring] and confirm that the monitoring 
function has become disabled. 

 

Figure 5-9  State of Serial Communications 
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2. Disconnect the serial connection. 
Click on the [Disconnect] button under "To Connect UART" under " 4. Coding and Monitoring" of the 
workflow diagram. When disconnection is completed, "Disconnected from ¥¥.¥COMx." is displayed in the 
Console view, and the label on the [Disconnect] button changes to [Connect]. 

   

Figure 5-10  <Step 4> Coding and Monitoring: Disconnect 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION ("Vulnerability Issues"). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for 
Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 

  

 
  

https://www.renesas.com/
https://www.renesas.com/contact/

	1.  Installation
	1.1 Installing the IAR EWRX
	1.2 Installing the Smart Configurator
	1.3 Installing the Standalone Version of QE for Capacitive Touch

	2. Preparing a Project
	2.1 Creating a Configuration File
	2.2 Setting the Smart Configurator
	2.3 Generating Code
	2.4 Setting the Project Folder and Target MCU

	3. Preparing the Touch Interfaces
	3.1 Creating a Touch Interface Configuration
	3.2 Outputting Files for Tuning Touch Sensors
	3.3 Implementing Programs for Tuning
	3.4 Building a Project

	4. Tuning Touch Sensors
	4.1 Connecting the RSK-RX140 Board with a PC
	4.2 Starting Tuning
	4.3 Acquiring the Tuning Result

	5. Coding and Monitoring
	5.1 Monitoring
	5.2 Disconnecting Serial Communications

	Revision History

